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The My City Houston interactive mapping web sites provide the city employees and citizens of Houston a means
to access the most current geographic information systems (GIS) data and aerial imagery (current and historical).
These data are hosted within the City’s enterprise GIS system that Mayor Bill White initiated in 2006. Users of the
web site ares provided with a variety of search and identify tools to assist them in finding information relevant to

their needs.
Background

The My City Houston applications are web-based mapping
applications that allow the users to interact with over 200
map layers and datasets that are relevant to the City's
mission. The sites also include multiple sets of aerial imagery
and scanned maps. Access to real-time data for traffic
conditions, traffic cameras, and stream gages is also
provided. The enterprise GIS Team used the same
application design employed for the My City-Recent Crime
site that they had earlier developed with the Houston Police
Department. The common look-and-feel helps assure a
similar user experience for the across mapping applications.

The City Map Layers tool provides access to the full set of
map layers, aerial imagery, and scanned maps. Users can
select either the Locate Address and Locate Feature tools to
quickly navigate to specific addresses or features (Council
Districts, Super Neighborhoods, KeyMap grid, Lambert Tiles,
Zip Codes, efc.) . A special “Layer Toggle” menu provides
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An example of the Search Permits tool.

a quick way for users to display high interest map layers. A
“drill-down identify tool provides users a means to quickly
find out a lot of information about a location, with handy links
provided to navigate the users to extemmally hosted
information (appraisal district property records, Google
StreetView™, county web sites, etc.). The site also provides
the first map-driven access to the city's ILMS building permit
data (ranging back to 1987) with its Search Permits tool. The
executive viewer includes a 311 Calls tool that allows the first
map-driven access to live 311 call data. A redlining tool is
also provided to allow the users to annotate the map. This
tool includes the ability to save the graphics to a file. This file
can then be transmitted to others so that they can be re-
loaded on to My City from another location or at another time.
The site also includes a print to PDF function.

Technical Information

The site is based on the Environmental System Research
Institute’s (ESRI) Adobe Flex API. The following browsers
can be used: Intemet 7.0 or higher, as well as recent versions
Google Chrome, Firefox, Safari, and Opera. The appropriate
Adobe Flash Player 10.x plug-in (version 10.x or higher) for
the preferred browser must be installed. The higher version
of the Adobe Flash plug-ins required to support printing to
PDF.

Help documents can be downloaded using the Help Menu or
the splash screen.

The City's GIS data are ever-changing. The enterprise GIS
team has gone to great effort to assure that the data in this
application are of high quality and that they will remain as
current as possible. This has involved forging agreements
between the departments responsible for each dataset, and
working out processes for regular update of each dataset.

General questions about My City Houston can be directed to
our GIS Helpline at (713) 837-7777 or to Max Samfield
{Max.Samfield@houstontx.gov) . For technical questions,
contact Daniel Bally {Daniel.Bally@houstontx.gov) .




Interface and Menus

Application Requirements

To run one of the My City family mapping applications, one must have a machine with an
Internet connection and a browser that meets the following requirements:

¢ Internet Explorer 7.0 or higher, or

¢ a recent version of Firefox, Safari, or Opera (Google Chrome is currently being

tested),

and

¢ the appropriate Adobe Flash Player plug-in (10.x or higher).
Most computers will already have the Flash Player installed. Typically, the application does a
check to see if the correct version of the Flash Player is installed. If not, the user will be
prompted to download and install it.

In general, if the user is not using an appropriate browser version or you do not have an
appropriate version of the Adobe Flash Player installed, the application will not load properly.
The user may see the menus and tools load, but a gray screen where the map should be. If
the browser is not able to issue a prompt indicating the need to install the Adobe Flash Player,
or if the automated install process does not see to work for some reason (browser security
settings, anti-virus software issues, etc.), the user can navigate to the Adobe site
(http://get.adobe.com/flashplayer/ ) to download and install the Flash software manually.
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Interface and Menus

Using the Application
When the My City mapping application loads, the user will first see a gray Adobe Flash Player
pre-loaded run in the middle of the browser window (it says “Initializing”) . After this process
completes, a pop-up window (see screen grab on the left below) will be visible that includes a
tabbed interface that allows the user
e to see application announcements (top of disclaimer, if applicable, and items
accessible via the News tab),
e to view and accept the disclaimer in order to be able to start using the
application,
e to download the help documents,
o to read new items that generally announce new datasets, functionalities, and
tools, or that may alert the user to a problem that has been identified,
e to read general information about the application, including who to contact to
report problems and to request additions or changes to the application.
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The user must click the “Accept and Use Application” button to close this window and start use
of the application (see screen grab on the right above).

The initial scale of the map will depend on how much browser real estate is available. The
initial map display shows the COH Street Map as the background map, with the HPD
Divisions, labeled by name, are outlined in navy blue. HPD District boundaries are also show
in a lighter sky blue, but these are not labeled by name at the initial map scales. The legend
for the HPD-related components of the map is show between the two possible first initial
displays to add the user in identifying these data.
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Main Controller Menu
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Interface and Menus
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The Mam Controller menu appears |n the top Ieft portlon of the browser window. It can be
minimzed or maximized by a click on the My City Houston icon. On the top right, the Main
Controller menu contains smaller shortcut icons that the user can click to access the most
commonly-used tools. There are also five larger icons on the center, bottom portion of the
Main Controller menu that are used expand and access menu items. By moving one’s mouse
over the larger icon, the menus will expand so that a selection can be made.

9 The first “Globe” icon triggers the “Map Menu”, which allows the user to change
background maps, load the City Map data tool (which gives users access to the full array of
data available in My City), load an overview map, print, etc.

¥ COH Hybrid Map (2008)

% Regional Hybrid Map (2006)
¥ COH Aerial Map (2008)

\' Regional Satellite Map (2008)
#% COH Street Map (2008)

F‘ Regional Street Map (2006)

#* Topographic Map
I "o Background Map
#¥ city map Data

#2 Overview Map

B B8ookmarks

Gy Print

The COH Hybrid Map (2008) background map is made visible, which is the COH
Street Map overlain on the COH Aerial map.

The COH Regional Hybrid Map (2006) background map is made visible. This is the
Regional Street Map overlain on the Regional Satellite map.

The COH Aerial Map (2008) background map is made visible. These are aerial
photographs taken circa January, 2008.

The Regionall Satellite Map (2006) background map is made visible. This is an aerial
map made of satellite and aerial image from circa 2006.

The COH Street Map (2008) is made visible. This is the default map at startup.

The Regional Street Map (2006) background map is made visible. Some features
may be outdated (wrong names, missing, etc.).

The Topographic Map background map is made visible. These maps are very
outdated as most were last updated in the 1970s, however, some people like these.

No Background Map is used with this selection. The user is able to change the
background color using the tool on the top left corner of the window.

The City Map Data tool will be opened. A table of contents will be shown that allows
the user to tum on/off the layer of City Map data as needed.

The Overview Map tool will be opened, showing a inset map with the current map
extent of the main map window indicated as a red rectangle.

The Bookmarks tool will be opened. This tool allows the user to save bookmarks for
specific areas of interest. They are specific to that one computer and user.

The Print tool will open to allow the user to print the map.
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% Interface and Menus

a The second “Compass” icon provides access to the Navigation tools and the Clear
Graphics tool (these are more easily accessed from the smaller shortcut menu buttons on the
top right portion of the Main Controller menu).

I

Zoom In

Zoom Out
Zoom In 1 Level
Zoom QOut 1 Level

| &L Full Extent
Pan/Re-center Map

' Clear Graphics

The user will be able to zoom in on an area by drawing a rubber band box on an area of
interest on the map.

The user will be able to zoom out around an an area of interest on the map by drawing
a rubber band box on the portion of the map that is at the center of that area of interest.

The map will zoom in one map scale level.

The map will zoom out one map scale level.

The map will zoom to full extent.

The user can re-center the map by using the hand tool to drag the map in the desired
direction.

This tool will clear any graphics (highlighted address, search areas, highlighted
features, etc.) from the map.

wThe third “Tools” icon provides access to special tools for interacting with application
data. Only a few of these tools can be accessed using the Shortcut menu

@ 311 Calls
<. Search Miscellaneous
> Search ILMS Permits
E Legend
_ Locate Address
Locate Feature
/ Draw
Crime By Area
-4, Crime By Address
T Houston Traffic

¥ Traffic Cameras

\.; HCOEM Stream Gages

identify

The 311 Calls tool is used to query and show 311 Calis on the map. There is a
shortcut menu icon for this tool.

The Search Miscellaneous tool is used to search Parcel Appraisal data, view Parcels
using Google StreetView, and other general search functions.

The Search ILMS Permits tools aliows users to search out ILMS Permits such as
building permits, demolition permits, certificates of occupancy, etc.

The Legend tool shows the map legend.

The Locate Address tool allows a user to find and zoom to an address, plus search
out Jurisdiction Info, Solid Waste Collection schedules, and HPD jurisdictions.

The Locate Feature tool allows a user to find a KeyMap Page or Block, Zip Code,
Super Neighborhood, Council District, Lambert Tile, or GIMS tile, and zoom to it.

The Draw tool allows the user to draw on and/or annotate the map. These
annotations are printable.

This tool allows users to see Recent Crimes for the tast 30 days by Zip Code, Super
Neighborhood, Council District, Police Division, District, or Beat.

This tool allows users to see Recent Crimes for the last 30 days for a buffer area
around an address.

This tool allows users to see Houston Traffic incidents are reported by Yahoo Traffic.
These data will ultimately be replaced by Houston TranStar traffic incidents.

Houston TranStar traffic camera images can be seen with this tool.

Links are provided to show the status of stream gages in Harris County as reported
by the Harris County Office of Emergency Management.

The Identify tool performs a drill-down identify of all data in the system for a location
that the user identifies by clicking on the map. There is a shortcut icon for this tool,.
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#l‘ he fourth “Layer Toggle” icon provides a quick way to simply turn on or off commonly
used map layers. Each button except the bottom button (which turns all of these layer off if
they are on) acts as a toggle.. If the layer is already drawn on the map, it will be removed. If it
is not shown on the map, it will made visible.

e e T
Parcel Address Labels

j - Parcel Boundary Overlay
B Houston City Limit
I City of Houston ETJ
City Council Districts
'3; Super Neighborhoods
X _""r Police Jurisdiction/Facilities
.___-,.4' Parks (City of Houston)

m Park Sectors

. KeyMap Page
; . KeyMap Block

m Histornic Districts (City of Houston)
& Prohibited Yard Parking Applications

,' Airport Tiers

M anoff
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Interface and Menus

6 City of Houston Home
@ Planning and Development Home

" About

This document will open in or eise the user will be prompted to download or save it
(if Acrobat Reader or a similar application is not installed on the user's computer).

The City of Houston home page will load in a new window or tab.

The Planning and Development Departments’ home page will load in a new window
or fab.

The About tool provides information on the team that developed the application,
support contacts, and another rendering of the disclaimer.

Shortcut Menu Items

PoeeegeyesB

The shortcut menu provides quick access to commonly used tools. These are (from left to
right) City Map Data, Print, Zoom In, Zoom Out, Zoom In 1 Level, Zoom out 1 Level, Full
Extent, Pan/Re-center Map, Clear Graphics, 311 Calls, Legend, and Identify.
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Interface and Menus

The zoom slider on the left side of the map can be used for basic navigation (zoom
in/zoom out ). Click on either the + icon at the top of the slider to zoom in. Click on the —

icon at the bottom of the slider to zoom out. Alternatively, click on the slider triangle and
drag to the desired zoom level.

1I-6



Ll
2 3\ ..J - ssuepunoq Auedoid Jo uoneoo| safeiel ejewixoidde ey} sjuesseides Ajuo pue AsAms
% 1 Lm punosB-ay-Lio ue jussesde: Jou seop pue sesodind Bukeains Jo ‘BuiesuiBue ‘ebay io}
ays, . ajqeyns 8q 10 10} pasedeid ussq ey Jou ABw pue sesodind feuopeuLIojul oj AUo S| dew ey
Srong o™ JBWiRPSI]

uoneolddy AnD AN au} Aq pajelsua
eaJe opeulo |

Vg 210 -ﬂngganltag 0V L0010 A1 80T WbidoD &
{

8 B | B "B | 8

}
1

XD
610
&3
B
se 1)
5 01j
evat)
o)
&
11.01)
am

15 URACUOg M IS UBRACUOCO M

|

3B
2ot
ozot)
5691

am
bi 5t
X3
0
96 21
o
an
am
o
o< £1]
vELT
17384

e

\\.\

T |

w 1T
| L

~ oapueley

b
,

byl U uRieN




6 %
" : 1
Locate Address i
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The Locate Address tool will show up in the top right portion
of your browser window when the application first opens. If one
exits the tool, it can be brought back by selecting the Locate
Address tool from the Tools menu (see graphic to the right).

To use the tool, click once on the tool to open it up.

Type in an address and/or zip code in the boxes provided.
Zip code is preferred but not optional. Street types are preferred
but not required. Often, if you are not able to get a match if you
left off the street type and/or intersection, you can add on a
street type, even if it is wrong, and then get a match. This is due
to the way that address geocoding tools attempt to standardize
addresses prior to performing the matching operation.

An intersection can also be search for using syntax such as
the following: Louisiana St@Walker St .

Once the address has been entered, click on the L.ocate

button.

I ocate Addeess

I8t W MacGreger Way

The tool will attempt to locate (or geocode) the address. If
results are found, the tool will switch to the Results pane and list
them. The map will zoom to the area around the best match
and also highlight that address. If the user wants to zoom to one
of the other resuits, simply click on that result listing in the table
shown in the Results pane.
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. Search Miscellaneous

I &) SearchILMS Permits

E Legend

"~ Locate Address
R I_o-c;)te Feature
/ Draw

T Houston Traffic

¥ Traffic Cameras

|4y HCOEM Stream Gages
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To find out Jurisdiction information for the selected address,
click on the Jurisdiction button.
The resuits will show up in the Jurisdiction info pane:

The user can also go back to the Results pane and click on
the Solid Waste Schedules button to report on solid waste
collection schedules for an address.

The results will be shown in the Solid Waste Schedules pane.

If the address falls in a recycling pick-up area, a link is provided
the Solid Waste Department page that lists printable schedules
for recycling pick-up.

Hl-2

Using the Locate Address Tool

Jurisdiction results include
information on the following:

Mayor’s Office and link to web site
Council district member and link to
web site

At-large council members and links
to web sites

Super Neighborhood name and
number, link to Planning and
Development Dept web page
Information on whether the location
is in the city limits (FULL vs
LIMITED purpose area) and/or in
the Extra-territorial Jurisdiction
(ETJ). If is a Limited Purpose Area,
it will report on the types of city
service provided based on the
original agreement with the
appropriate Municipal Utility District
(MUD).



1 Using the Locate Address Tool

Similarly, one can go back to the the Results pane and click on
the Police button to find out the HPD Police Division, District,
and Beat for the address.
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it Using the Locate Feature Tool

Locate Feature

" N

At startup, the Locate Feature tool will show up in its
minimized form in the top right portion of your browser
window - just under the Locate Address Tool. If one exits
the tool, it can be brought back by selecting the Locate
Feature tool from the Tools menu (see graphic to the '
right). ¢ . Search Miscellaneous

If the tool is minimized, start using the tool by clicking
on the icon part of the minimized tool. This will cause the ‘
tool to expand. E Legend

By clicking on one of the first two small icons on the
top of the tool window, It is possible to select either a

Text Search gor a Graphical Search Q The Text

&) Search ILMS Permits

v . Locate Address

¢ . Locate Feature

Search is the default search mode. /. Draw
Text Search Q— If Text Search is selected, use the T Houston Traffic
Search Layer dropdown list to select the search layer. :

The choices are City Council District, Super | ¥ Traffie Cameras

Neighborhood by Name, Super Neighborhood by No.,
KeyMap Page, KeyMap Block, Lambert Tile, GIMS Tile
(Public Works uses this), or Zip Code. Note — these
selections may expand in the future, but not necessarily
appear in this documentation.

L,;i HCOEM Stream Gages

-— . 3 < . 4
- Locate Featine v o ” '

City Council District
OO i Coundl District
Supar Neighborhood by Name
Super Neighbarhoed 5y He
Fayias Cage
Kayliap Block

Once the Search Layer is selected, enter a string that
corresponds to appropriate text to use in the search.
Examples are provided for each type. For all cases
except Super Neighborhood by Name, the search is an
exact, but case-insensitive search. For example, for City
Council District, one enters either A or a to locate that
city council district. For Super Neighborhood by Name,
one only needs to enter a word or words appearing the
the Super Neighborhood name. For example, entering
the string acres will produce two results as there are two
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Using the Locate Feature Tool

Super Neighborhoods that have the word “acres” in
their names.

Once the string is entered, click on the Search
button.
The search will initiate and the tool will flip the panel to
the Results panel (this panel is indicated on the top right

icon panel by the —- icon. Any results will be listed
there, plus the map will show the result feature(s)
highlighted in a semi-transparent red color. If one clicks
on a one of the results listed in the Results Panel, the
map will zoom to and highlight that single result. The
highlighted features can be cleared by clicking on the
Clear button in the Text Search panel, or by clicking on

the Clear Graphics tool Zin the Shortcut Menu on the
Main Menu Controller.

Graphical Search ;,Q - If Graphical Search is selected,
use the Search Layer dropdown list to select the search
layer. The choices are City Council District, Super
Neighborhood by Name, Super Neighborhood by No.,
KeyMap Page, KeyMap Block, Lambert Tile, GIMS Tile
(Public Works uses this), or Zip Code. Note — these
selections may expand in the future, but not necessarily

appear in this documentation.
N Locate Featue 4
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Then select one of the graphical search tools to select a
feature by clicking on the map (Select by Point ') or
drawing a feature (Select by Rectangle - or Select by

Polygon E). Once the feature is drawn, any features in
the selected Search Layer will be selected and
highlighted. A list of results will be shown in the Results
panel. Once again, clicking on one of the listed results
will cause that single result to be zoomed to and
Iﬁhllghted
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The highlighted features can be cleared by clicking on
the Clear button in the Text Search panel, or by clicking

on the Clear Graphics tool # inthe Shortcut Menu on
the Main Menu Controller.
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